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OverView 

Advantages over Excel… 
 
 

·  Cannot damage data with sorting 

·  See Timeline Gantt View 

·  Linking of tasks – so change main tasks – alters starting times of linked tasks as well 

·  Easily assign multiple people to multiple tasks 

·  See before & after (Tracking Gantt) 

·  Collapse & Expand by area. Etc. 

·  Filtering Power 

·  Grouping Power 

·  Tracking Completion of tasks 

 

Assumptions 
 

·  Duration = Work/Units.  The calculation of Work, Duration, and Units was (still is) my biggest 
trouble to figure out in Project.  It is the core of what Project does and it cannot be turned off, so 
one must deal with it. Everything that Project does is based in some way on the calculations that 
this formula makes.  Other settings in Project such as calendars and hours of work effect the 
equation.  This can often be difficult to estimate, particular for a supporting tradesperson which 
plays a bit role in the tasks.  It becomes lots of fun when all of the resources are working off of 
different calendars!  I guess what I am trying to say that this formula is a Microsoft Project truism, 
and even if you do not agree with it (I often don’t), this formula is what Project uses and it must be 
taught. 

·  Project is very personalized at the level of the user and the user’s computer.  A Project 
created on one computer will not look the same on a differently configured computer.   If 
Greg is training a people who will interchange data, some time agreeing on template format 
might be valuable. Really, we should have Project implemented as enterprise software 
running on a server with identical resources (tradespersons) and calendars; or at least lots 
of templates.  
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http://office.microsoft.com/en-us/project/HA010745311033.aspx 
 
File > New > On my Computer  > Residential Construction   
(note Curing time is WORK and is 9 days ! ) 
 
 
 

 
 
 
 
 
 RESOURCES 

(People and Equipment) 
(View – Split / Remove Split) 

TASKS (WO) 
Grouped by FXN LOC &  WO# 

GANT CHART 
(Timeline of task- shows resources) 

TOOL BARS 
VIEW BAR 
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New Project Wizard; 
If you do not yet have a template with default calendar setup and resource table define with 
resource calendars,  the Wizard can be very helpful in defining your settings. 
 
Consider saving the final result as a template for future similar projects. 

 



  7 

 

Read Only? 
 
When you open the MS Project File from the Server – it may already be opened by another 
Planner / Supervisor – you may encounter this dialogue box;   

 
If unsure – try a File – Save – if it is opened by another user, it will force a SAVE AS – not 
allowing you to update the original file… 

 
 
Also, the Title bar should say “Read Only”  
 

 
Best to EXIT - do not make any changes, since your changes will be lost – or is you save the 
read only file – those changes would have to be done again in the original file… extra work 
and possible errors. 
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New Project Lesson 
 

1. Upon Entry into MS Project from START – PROGRAMS  or FILE – NEW – 
Blank Project “ template”  (or manually select Project > Project Info ) 
 

 
 

2. Accept defaults (MS Standard Calendar is 8 hours work in a day, weekends off) 
Default start date is TODAY, 8:00am 
Default View is Weekly – grey areas are non-working times 
 

 
 
Default Duration of Tasks is in Days; 

 
3. Key in the following Tasks (Down arrow to next row or [Enter] key) 

 

 
Note:  Column widths can be increased or auto-sized via double click column 
junction) 
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4. Change the duration of DIG PIT to 2.5d 
 

 
durations – 1m, 1h, 1d, 1w, 1mon (not Month based) 
Note: Duration Estimates (3h?) 

Summary Tasks 
Summary tasks are Headings that define a group of tasks.  They will automatically tally the 
total duration of that group of tasks as well as allow you to collapse them to hide them from 
view when you want just an OUTLINE of the tasks. 
 

5. Right click row you wish to push down (as in Excel) – New Task (or [Insert] key 
 

6. [Tab] over to Description Column – Type Heading “FOUNDATION” 
 

 
 
 

Indent I tems 
7. Select the DIG PIT row (2) 
8. [Shift] select the POUR CONCRETE row (5) 
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9. Demote as Sub-ordinates (Indent to the right) 
 
or hover on one description – when see double headed arrows – drag to right to 
Demote 
 

 
 
 

10. Note how FOUNDATION has become bold – and the Gantt bar is black 
 

 
 

11. Click the minus icon to collapse details 
 

12. Click the plus icon to expand again 
note: Summary tasks should be collapsed before adding more tasks – unless you 
want them also within that Summary group 
 

13. Add the Following Summary Task and tasks 
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14. Indent the FRAMING tasks (task 7 through 11) 
 

 
 

15. Change the durations to the following (use arrow down for next row) 
 

 
 

16. Expand the FOUNDATION tasks 
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Link Tasks 
17. Linking Tasks – Select the FOUNDATION Tasks and Link   

 

 

 
18. Note the Summary task now tallies the total duration 

 

 
The Gantt chart illustrates the task order as well 
 

19. Tab into the start column of the DIG PIT task – edit in the edit bar a few days off 
 

 
 

20. Note how the entire FOUNDATION group has shifted over  
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21. BONUS: There are other ways to delay the start of a project of OPERATION, one is 
to have a linked task of zero duration called “PROJECT STARTS” – this is called a 
milestone, could be for waiting for license, etc. 
 

 
 

22. Another method to delay the entire project – Project – Project Information 
 

 
 
Select the dropdown arrow on Start Date field 
Select Start Date from pop-up calendar; 
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23. Link the FRAMING tasks; 
 

 
 

 
 

 
 

24. Lastly, link the FOUNDATION Summary task to the FRAMING Summary task – 
using [Ctrl] select to select non-adjacent items; 
 

 
Cr itical Path – The Tasks that determine the start and end of the project, usually 
connected tasks that a change in one effects the others and hence the project’s end 
date & time.  To see the critical path, use tracking Gantt – they show up in red, or we 
will see later how to filter. 
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25. Note Problem! – Cement will be a mess if remove forms before dried…  need delay 
– called lag time or elapsed time – see settings of FRAMING Task – double click 

task or  
 

 
 

26. Set Lag to at least 48eh  (2ed); (e = elapsed, does not count as 8 hours in a day) 
 

 
 
Note: Elapsed  (3eh) to disable calendar constraints 
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27. Other Problem – The pour of cement must happen in 1 full day, not 2 half days… 
Would be best to allow the weekend for drying time?  Perhaps reduce the DIG PIT 
task to 1.5D (an extra CAT) 
 

 
 

28. Save – With a baseline – so as you alter the project, you can compare before and 
after views via Tracking Gantt. 
 

 
 
Tools - Tracking - Save Baseline 
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29. Try changing Trusses to a longer length – then look at Tracking Gantt; 

 
 

 
 

30. Back to Gantt View;  

 
 

31. Calendar View; 
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Resources 
32. To create or manage resources (people, machinery or consumables) – Resource 

Sheet View; 
 

 
 

33. Fill in three people as below;  Group could be the TRADE 
 

 
 
Note: Resource Calendar does control when the resource can work, and will effect to 
Task start time and duration, unless you make tasks resource independent. 

Under Task settings;  
 
Note : Deafult is to have tasks effort driven – so if you put two people on the job, the 
duration halves. Tools > Options to control this option or Task settings to fix it.  

    
Note: You could have Resource names be CA1, CA2, CA3, LA1, LA2, etc and 
when you know who you will have, replace the generic names with proper 
names…You can create this in EXCEL and copy over. 
 

34. Scroll to the right and note using Standard Calendars (8 hour work day with lunch 
break) 
 

 
note: Resource Calendar initially based on Base Calendar… 
 

35. Must be “hard”  sorted – so listing appears in correct order… 
Project – Sort – Sort By… 
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Note: by Name  and Permanently renumber resources… 
 

36. Back to Gantt View 
 

37. Assign Resources to selected job(s) – select with [Shift] or [Ctrl] depending upon 
situation – then; 
 

 
 

38. Select name(s) and Assign; 
 

 
 

39. Note Dialogue box does not close, so you can now select CA jobs and assign both 
Mike & Paul to them; 
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Note: Close when done… 
 

40. See over allocations – Window – Split 
 

 
Then Click in bottom Window Pane and activate Resource Sheet View; 

 
 



  21 

 

41. Note: Names will appear in Red if over-allocated via over-time or working two 
places at one time; 
 

 
 

42. Add Build Shed – 2d; move task under REMOVE FORMS (hover – when 4-headed 
arrow – drag & drop) 
 

 
 

43. Assign Mike to that task;  
 

44. Note: Name appears with warning and in RED; 
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45. Remove Mike and assign Fred to build the shed…or select Replace – select Fred - 
Close 
 

Completion 
46. To mark a task complete or partially complete – Right click toolbar area – Tracking; 

 
 

47. Percentages mark complete  - try one task 50% and another 100%, then tag the 50% 
task back to 0% 
 

 
Note: the black completion bar in the Gantt 
 

48. Add Progress Line – shows where you are at and where you are falling behind; 

 
 

49. Note the jag back – shows where behind schedule; 

 
 

50. To Remove – double click line – Delete option 
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Filters 
51. Auto Filter; 

 
 

 
52. Note the choices – one is custom;  try Duration >1d 

 

 
 

 
53. Note the Column Label is now blue and some row numbers are missing (hiding) 

 
54. Show All – Duration Drop down – ALL – or quicker and safer – Toolbar Filter – All 

Tasks; 
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55. Custom Filter – Try Task Name Dropdown – Custom; 
 

 
 

56. Filter Dropdown in Toolbar – Critical / Completed Tasks / Un-Completed, etc. 
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Printing 

57. VIEW as desired then - File – Print Preview   
 

 
 
Page Set-up – Margins / Header / Footer / Add Field info 
 

58. Reports  - View – Reports 
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59. OverView 
 

 
 

60. Current Activities 
 

 
 



  27 

 

61. Costs 
 

 
 

62. Assignments 
 

 
 

63. Work Load 
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64. Custom – Select base Report to Edit or Copy or make a new report 
 

 
 

65. Custom Filters / Views / Reports / Settings / Templates – PART 2 MS Project… 
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Settings 
Your global date display time as 24 hour clock 
 

 – Settings – Control Panel 

 

Disable MS 2000’s Hide Menu Choices 
 
View – Toolbars – Customize – Options;  

 
De-activate “Menus show recently used commands first”  
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Project Start / Base Calendar; 
Project – Project Info; 
 

 
 
Tools – Options – View - date format to display both date & time  

 
So when change the time it keeps the correct date  
 
Tools - Options - Calendar - Start time for new tasks added / Working Hours per Day/Week; 

Set as Default - all future new files take on that setting 
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Tools - Options - Schedule - Duration defaults to Hours 

 
 

So not subjective 
like a day could be 
8 hours or 24 hours 
depending upon 
what calendar you 
choose as base 

If effort driven, more 
people put on the job - 
lower the duration 
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Format - Timescale - To Days & Hours - 8 units to show - so day shows as three blocks 

 
 
Non-Working Time -  Based on 24 hour base calendar or standard – or NEW to add other 
base calendars – to base Resources on…  Night Shift / Day Shift / etc. 

 
The Default button does set your main template for new files.  You can also have different 
templates for different types of Projects – File – Save As – Type Template…  as in Word / 
Excel… 
 

Organizer 
To transfer custom objects from templates or files – Tools – Organizer; 
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Sorting 
Project – Sort; 

 
 
Sort By; 

 
 
Permanently renumber tasks can be deadly…  having a backup file is critical if doing such 
manipulations.  Remember – only one undo in Project.  Better to use filters and groupings 
rather than sorting (safer).  Perhaps have a custom filed as a copy of the ID field in case you 
do a permenent sort. 
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Grouping 

 
 
or Project – Group by; 
 

 
 
Customized – can group by Functional Location / Supervisor, etc… 
 

 
 
Change back – No Group… 
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Basic Formatting 
 
Format – Font 
 
Save after every major successful edit 
 
Format new task perhaps as Green – larger font…  Format – Font 
Perhaps RED to suggest delete, BLUE to indicate change and GREEN to indicate new task 
 
The format of  the Description can be copied and ‘painted’  onto other row(s) 
 
1. Click in the row you like the look of 

2. Click the Paint Tool   

Click on row(s) to be ‘painted’  
 
Format – Text Styles 
Format  - Bar Styles; 
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Views 
View - Zoom  - Entire Project (Gantt showing all bars on screen) 
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Expand / Collapse Level 
 

 
Plus to Expand / Minus to collapse again (to show what you want to see or hide it) 
 

 
Expand a WO – shows the sub-operations as well 

 

To Collapse – select the column – then minus Icon   (what is selected is collapsed again) 
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Columns 
 

Widths 
Select the junction between columns to manually resize – drag to the right… 
 

 
or Double click there to Auto-size (just like EXCEL) 
Double click column Label – to edit size numerically or change label / position / type 
 

 
 

New Field; 
Right Click – Insert  

 
 
Lots of custom text fields, number fields and date fields 
Keep a reference sheet of Fieldname vs. Title – when filtering, etc. need to refer to 
fieldname which is obscure – unless RENAME them… 
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Navigation / Editing 
Arrow keys to cycle row by row 
Arrow keys to go left & right (can use [Tab] [ Shift][Tab] as well) 
 
[PageUp] / [PageDown] 
[Ctrl][Up Arrow]  / [Ctrl][Down Arrow] for top or bottom of project 

To see the Gantt Chart of a task – scroll over to it or   will jump you there! 
 
When on a field (like Duration) just type new number– types over existing automatically 
Note: 15 minutes  = .25  not .15 
 
Note: bold duration – calculated field (heading) cannot edit  
Note: duration defaulted in hours 
 

Error?  Undo with [Ctrl][z]  or Edit – Undo  or    or Re-Do    only one chance! 
 
Delete task = [Delete] key 
 
Delete cell = [Ctrl][delete]  or right click - clear 
 
Note: delete a heading – deletes all items within that heading – warns you first - OK 
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Select Multiples 
Multiple rows can be selected for; 

�  Formatting (Format – Font) 
�  Copying  - Edit – Copy (or [Ctrl][c]  
�  Deleting – [Delete] key 

�  or Linking  or un-linking   (the order you select is the order they are linked) 

�  or Assigning same person(s) to multiple tasks  
�  or Group Editing 

 

Non-Adjacent 
Select first item – [Ctrl] select others 
 
 

These three are selected 
 

Group Selection: 
 
Select one – [Shift] select another a few rows down – all in between are selected 
 

The first row is selected as well, just shows slightly different – since it is the current cell, 
where your typing would go… 
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Group Edit 
Select multiple tasks 

Go into the Task Info – right click – Task Info or  
 
Shows blank – enter value(s) you want for all selected items (be careful) 

 
Useful to change durations / start time / percent complete  of non-adjacent tasks 
Assign a resource to many tasks using the resource tab 
and advanced tab to force deadline, constraint or Task Type – effort driven, etc. 
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New Task 
 
1. Right click row number – New Task 
2. or [Insert] key to insert a task – pushes one you are on downwards 
3. Type description 
4. [Tab] to duration field 
5. Type duration value  
6. [Tab] to Work Center –Trade ? – MW / EL / IN / CA / PF / OP / WE / LU / MA / SM /LA 
 
While on this new row, you can set the start time as well 
 
Note:  collapse all WO before inserting a new task – unless you want it inside that WO 
 
Recurr ing Task – Insert – Recurring 

 
 
Practice:  Add a task under a WO Heading 
Practice:  Expand the WO Heading – collapse again – your addition stays visible? 
Practice:  Expand the WO Heading 
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MOVE TASK 
Warning:  Moving a heading can move just the heading if the items are not collapsed within 
– would leave the items into the heading above…  Cannot be undone – so backup first 
before major manipulations… then work on the original file.   Cut & paste seems to work 
best for moving sections around.   

 
If you see this dialogue box – probably things have been wrecked – undo [Ctrl][z] and try 
again…   
Note: even un-collapsing a heading is using up your one undo… 
Moving a task into a linked area will link that task as well in the flow – unless deactivated – 
Tools – Options – Schedule – Autolink Inserted or Moved Tasks 

Task Details 
 

  or  Right Click Task – Task Information / Task Notes  
 

 
or Double Click any Field 
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Notes 

 
To store a note to a task (detail information about the task) 
 

 
Hover over the Info Box icon of a note – pops up the note (may have to widen the column) 

General 
Start Time / End Time  

 
Percent complete (easier with buttons) 
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Linking Tasks 
 
Planners – need to join tasks as a job may depend on a previous job before it can start.  Ex.  

Before the foundation can be poured the forms must be built… 
 
Just key in the job(s)  ID that must be completed first – its Predecessor. 

 

This process can also be done by [Ctrl] selecting the tasks in order - and linking them   
Note: The order you select the tasks will be the order of the linking 
Note: Change start of linked tasks – all shift over 
 
Two or more Tasks (A&B) must be done before another (C)  can start 
Link A and C – then Link B and C  - easier to edit C predecessors to be A and B 

 
Lag Time – delay before that task can be started - Settings of a task – 2 h for 2 hours delay 
problem if do manually by dragging – forces a constraint  – better to do in task settings 

 
Lead Time – time task can start before prior job is finished…(-2 h) 
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Split Tasks 
To create a type of lag in a task… When the task must be interrupted due to resource 
conflict, availability or materials, etc. 
 

 
Then click on location within task to split and drag to the right… 
 

 
To re-connect, simply drag right part back to left part and they should merge. 
 
In Project 2000 – Task Information – Advanced – can set the task’s calendar as well… 

Constraints 
 
Start as soon as possible is the default 
 

 
The top 3 tasks are ASAP 
The last two are set As late as possible, so schedule back from project�s end time as that 
changes… 
 



  47 

 

Linking Documents 

In Notes – you can link or insert a file with  
 
The Task Description can also become a hyperlink to a document 

 
 

 
 
Web Page link, File Link, New Document Link another place in current Project file… 
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Linking Files 
You can insert other Project files or simply have the resources as a separate file that you link 
to as a resource pool. 
 
Insert - Project where desired…(some problems with inserted projects like changes to 
master do not effect slaves, links breaking is also a risk) 
 
In Project 2000, you can sort the master file as one large group of items, before each file 
could only be sorted as its’  own group. 

Strategies for organizing a master project and subproject files 

When you break up an existing project file into a master project and subprojects you 
should consider reorganizing by logical groupings such as the following:  

·  Tasks in separate phases of a project: For very large or complex projects, using 
separate subprojects for each phase can make it easier to see the details of your 
project. You can view the critical path of each phase because it is in a separate 
file, while in the master project, you can see multiple critical paths, one for each 
phase. You can still link tasks in different subprojects as you would tasks in a 
single project, but it may be easier to separate into subprojects those phases with 
the fewest dependencies to tasks in other phases.  

·  Tasks falling in similar time periods: It�s useful to organize tasks into subprojects 
when there are significant gaps in time between chunks of work in an ongoing 
project. By using subprojects, you can close out project files for periods of work 
that are completed.  

·  Different project managers� responsibilities: If you supervise several project 
managers working on parts of a larger project or in a program with multiple 
projects running concurrently, give each project manager a separate subproject. 
That way, you can see the overall progress of the program and how their projects 
or tasks fit within it while they retain the freedom to work on their subprojects.  

·  Sets of interdependent tasks: Separate related tasks from unrelated tasks and 
group each set into its own subproject. Keep highly related phases within the 
same subproject.  

·  Milestone scheduling: If you like to manage your projects by entering important 
milestones, you can create a subproject for the tasks that are related to each 
milestone. As subprojects, they are easy to roll up to a top level without having to 
create a summary task for each milestone as you would normally do in a single 
file.  

·  By work site: If work on your project is done at separate sites, you may find it 
convenient to schedule each site�s tasks in a separate subproject. For example, if 
you are manufacturing a product, work on some components may be done at 
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different factories. You can create a subproject for the tasks completed at each 
factory and create a master project for the product as a whole. This method makes 
it easier to see exactly where work is being done at any time, and gives individual 
managers more control over tracking the work at their sites.  

·  Related resources: Separate tasks into subprojects by groups of related resources 
so that those resources can manage their own tasks while you stay on top of their 
status at the project level. For example, the tasks of the engineer and CAD 
operator on each sheet of a large design/build contract could be in one subproject 
while the construction manager would have another subproject. The project 
manager would be able to see all the tasks in the subprojects within the master 
project.  

·  Resources assigned to repetitive tasks: If the project�s task list contains recurring 
tasks that are part of an internal process, it makes more sense to allow those 
groups to schedule their own time and be responsible only for deliverables or 
milestones. For example, if the accounting department is responsible for billing 
cycles and audits entered in the project as recurring tasks, those tasks can be 
added to a subproject and the manager of the accounting department can assign 
the tasks to the various accountants working on the project.  

·  Resources assigned to only one phase of the project: When small groups of 
resources are assigned to or interested in only part of the project, you can put 
them in a subproject. It more accurately reflects their view of the length of the 
project because it spans the length of their involvement. This technique also keeps 
the resource list of the master project limited to the resources that will be 
involved throughout the project, which can look most realistic when reporting 
resource information.  

·  Different budgets: If you have different internal budgets from which you are 
billing, it may be easier to view the budget totals if the tasks for each budget are 
in separate subprojects. You can still view the project cost totals in the master 
project, but you will have greater flexibility in viewing and reporting subproject 
budget totals.  
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Resource Pooling 
In case you want separate control over resources or have multiple resource files or a shared 
resource file with separate projects. 
 

What is a resource pool? 

A resource pool allows you to share resources among multiple projects. Using a resource 
pool allows you to schedule resources� work across projects, identify conflicts between 
assignments in different projects, and see how a resource�s time is used in multiple projects 
If you have people or equipment that work on tasks in multiple project files, you may want 
to use the resource pool to centralize resource information, such as resource name, calendar 
used, resource units, and cost rate tables, making it easier to administer. Each project that 
uses resources from the resource pool is called a sharing file. You can use any other existing 
project file as a resource pool, but it is recommended that you create a new project file just 
for resource information to make it easiest to manage resource information and task 
assignments between sharing files and the resource pool. 

 
Tools – Resources – Share Resources 
 

 
 
Under On conflict with calendar or resource information, choose which file should take 
precedence if resource information conflicts, for example, a standard rate of $30 in one file 
and $40 in another. Click OK. Note that assignment information is never overwritten.  

·  Select Pool takes precedence if the resource pool file that you want to borrow 
resources from should overwrite resource information in the sharing file. This option 
is highly recommended.  

·  Select Sharer takes precedence if the sharing file should overwrite resource 
information in the resource pool and other sharing files.  

Note   Resource information from each project is added to the new resource pool and made 
available to each sharing file as it is shared. 
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Resources 
Perhaps best if the tasks are scheduled and linked as need be prior to assigning resources – 
so conflicts show as true – that you have already assigned a person or Equipment to another 
task in that same time slot. 
 
Foreperson assigns resource to the task – Tradeperson / Operator / Equipment such as crane 
 
To manage the window panes of MS Project, click into the pane you want to alter; 
 

 
Then click on the View button of your choice – “Resource Sheet”  
 

 
So when you apply resources to a task – you will see easily who is applied and if there is a 
conflict – will show up in red. 
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Resource Application Icon 
 

   
 

 
Can select multiple people – Assign – leave window open for more assignments 
 
Can Select person – Re-Assign Task to another person…(REPLACE)  
 

 
Also very easy to remove or re-assign Resource(s) with this method 
 
As well shows conflicts right away 
 
Can select multiple tasks – assign same person or multiple people to multiplr tasks. 
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Add / Remove Resource 
 
Massive Replace?  

a) Select column of tasks viewed 

 
b) Assign resource method  
c) Select ‘sick’  or incorrectly assigned resource   

 
d) Select replace   
e) Select replacement resource then OK – Then Close 

 
 
If need replacing in entire file –  
Type over resource name on resource sheet  
 
Warning:  Remove a resource – if assigned anywhere – just disappears…best not to delete… 
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Resource Conflicts 
 
With the bottom Window displaying the Resource Sheet, if you assign someone or crane to 
a task overlapping time slots or working overtime based on their calendar – the name will 
show in RED. 
 

 

  To toggle to all over-allocated Resources (Conflicts) 
 
Selected tasks – shows the people working those tasks in bottom pane 
 
When looking at Resource Usuage, Window Split - then change the bottom window pane to 
Gantt to see where the person is working two jobs at the same time… 
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Resource Application Dropdown 
 

 
Tip: Just key in the trade then first few letters of person’s last name – then drop down list – 
will be ‘ there’  to select person (resource) 
 

 

 
Tip: Keyboard method – the first few letters as above, then [Alt] [Down Arrow]  
Then [Arrow] down to resource desired and [Enter] it is selected and you are brought down 
to the next row to assign another person if needed. 
 

 

 
Can add multiple resources to same task. 
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Completed Tasks 
Note: Editing a Heading WO completed (as deleting) - effects all sub-operations as well. 
 

 

 
 50% done vs not started 
 
if by error mark a task complete – just mark 0% 

Filters 
To show just what you nee to see… 
Warning:  Filters work on just expanded data (great when needed)  so if you want to filter all 

data – expand all first -  

AutoFilter 

 
Auto Filter creates dropdowns for each of your columns… 
So you can filter by Work Center of task / WO# / Hours / etc. 

 

Filter Dropdown; 
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The Base Calendar; 
The calendar the file is based upon – for working and non-working times & dates 
Project – Project Info; 

 
 
 
To modify the base calendar or to create other base calendars; 
Tools – Change Working Time; you can select the day headings to change week days or 
weekends and create your own “Standard”  – which will effect the resource “Standard”  
calendar as well. 
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New – to create new base calendars; 

 
New is based on Standard – 8am-5pm – 1 hour lunch 
 
Could make a copy of another calendar that is closer to what you want… 
 
 
The resources can be based on this or other base calendars then customized for that 
individual if desired. 
Go to the Resource Sheet View 
Scroll over to Base Calendar  - select from the dropdown the closest for that resource 

 
 
Then double click their calendar – Edit as needed; 
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Customize Fields 

Rename Fields 
so you can find them easier; 
Tools - Customize – Fields- Rename 
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Text with Value List 

Ex.  for SUPV  or TRADE, etc. 
 
 
If restrict field; Creates a dropdown – exclusive; 

 
 
Can have default value as well as appendable dropdown list. 
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Calculating 

 
Could also be used to TRIM or change case of a field….UCASE,  STRCONV 
 

Graphical Indicators 

 
 



  63 

 

Custom Toolbar 
 
Right click toolbar – Customize 
View – Toolbars – Customize 

 
New; 

 
Then populate with Buttons from Commands tab by drag & drop 
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Create Custom Filters 
Project – Filters – More Filters; 
 

 
Can Edit on to see the syntax required… 
 

 
Input box = value “Question”  ? 
All fields available and many conditions too 
Show in Menu is very useful if use this filter a lot 
Filter to show Tasks that are for trades that are MECH another for IN or EL 
 
Organizer – to populate it to your Global template or another file 
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Create Custom Reports 
Feeds from Custom Filters to isolate what you want… 
 
View – Reports – Custom; 
 

 

 
Select one close to what you think you want 
 
 
Copy 
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Give a descriptive name; 
 

 
 
Details to show on report; 
 

 
Sorting order tab as well… 



  67 

 

Baselines 
 
When you first save a Project it asks you if you want to save it with a baseline… 
 

 
If you do, the main baseline is the “before”  picture.  As you make alterations, the tracking 
Gantt view compares that to the baseline.  You can save multiple baselines (interim plans), 
such as on each morning of the shutdown.   
 
Tools – Tracking – save Baseline – to over-write it or save another baseline. 
 

 

 
Grey is before – blue is after, red is critical path 
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Reschedule Uncompleted Tasks 
 
During a shutdown you may fall behind schedule and need to re-schedule the un-completed 
tasks.  This can be done for you; 
 
Tools – Tracking – Update Project; 
 

 
Entire Project or tasks that you have selected…to Jun 5; 
 

 
 

 
Perhaps save a copy first as well as Baseline… 
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Macros 
 
To automate any repetitive actions within software… (WORD / EXCEL / ACCESS / 
POWERPOINT / PROJECT ) 
 
·  Edit – Replace 
·  Group Edit (Select multiples – Task Information) 
·  Custom Filters 
 
Ex.  – to format tasks depending upon the TRADE of the task.. 
 
Steps; 
1. Filter to show the tasks of that trade or group of trades (MECH) 
2. Select all 
3. Format – Bar Styles 
4. Show all tasks again 
 
Could create the one macro (EL/IN) then copy it and link to the other filter (MECH) so the 
macro would cycle through both groups. 
 
Tools – Macro – Record New Macro; 

 
 
Run the Filter EL/IN; 
Tools – Filter – More Filters (or on MENU?) 
 
Select the column header to select all tasks 
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Format – Bar Style – Select desired look for TASK middle… 
 

 
OK 
 
Filter – Show All… 
 
Tools Macro – Stop Recording 
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Edit Macro… 
Tools – Macro – Macros; 
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Copy & Paste Code 
 
Then Alter to requirements… 
 

 
 
Errors can happen in macros, typos, or if try this macro and have no EL/IN trades, it will try 
to select all and format bar styles of “nothing”  … 
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Cheat Sheet 
 
 

Insert Task [Insert] or [Ctrl][+] 

Delete Task [Delete] or [Ctrl][-] 

Screen up [Page Up] 

Screen down [Page Down] 

Top [Ctrl][UP ARROW] 

Bottom [Ctrl][Down ARROW] 

Select Group Select first then [Shift] select last 

Select Toggle [Ctrl] clicking 

Find [Ctrl][f] 

Replace [Ctrl][h] 

 
PROJECT 2000:  File - Save As - ©98 version - location? desktop? 
do not do FILE - SEND (Sends currant file in 2000 format! ) 
Attach icon from desktop to email it out in ©98 format... 
 
Video glitch – PageUp/down to fix 
 
*Flex time vs Lag Time (can show slack time as below) 

 
 
 
 


